CATIA - Functional Tolerancing & Annotations V5 product is a new-generation CATIA product, which allows the easy definition and management of 3D tolerance specifications and annotations directly on 3D parts.

The intuitive interface of the product provides an ideal solution for new CATIA customers in small and medium size industries, looking to reduce reliance on 2D drawings, and increase the use of 3D as the master representation for driving from design to manufacturing engineering process.

CATIA - Functional Tolerancing & Annotations products’ 3D annotations can be extracted, using the annotation plane concept in CATIA Generative Drafting product.

The product elements can be reviewed using specific functionalities, which constitute comprehensive tools for the interpretation of tolerancing annotations.

This manual is intended for people who need to specify tolerancing annotations on 3D parts. It assists the designer in assigning the correct tolerances on the particular selected part surfaces. The designer just has to:

- select the surfaces to be tolerated,
- choose among the proposed options, the tolerance types, the modifiers, etc. The system proposes options which are consistent with the selected surfaces.
- enter the tolerance value. The tolerance annotation is then created and displayed around the 3D geometry. It is also located and orientated in an annotation plane and this using a standardized model (usual standards: ISO, ASME / ANSI).

As a consequence, the designer does not have to wonder of the correctness of the tolerancing syntax because it is directly elaborated with regards to the chosen tolerancing standards (ISO, ASME / ANSI).

By the way, the designer is ensured that his tolerancing schema is consistent with the part geometry, second, he/she does not need to be a tolerancing expert, having in mind all the complex standardized tolerancing rules. Moreover the tolerancing specifications will remain consistent whatever the geometrical modifications are.

The information contained in this guide is specific to Version 5 Release 5 of the CATIA - Functional Tolerancing and Annotations workbench, which operates in a WINDOWS or UNIX workstation environment under the AIX, IRIX, SUN OS and HP-UX operating system.

**Normative References**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ASME</td>
<td>A standard is being developed on DIGITAL MODELING. This project will cover the representation of dimensioning and tolerancing annotations in the 3D space.</td>
</tr>
<tr>
<td>ISO</td>
<td>Standards are being developed for the specification of dimensioning and tolerancing annotation in the 3D space.</td>
</tr>
<tr>
<td>ISO 1101-1983</td>
<td>Geometrical tolerancing – Tolerancing of form, orientation, location and run-out</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
Final Draft International Standard (FDIS) - Revision of ISO 1101:1983,  
Note: The new ISO 1101 standard will be published in october 2000 and will replace ISO 1101-1983. |
| ISO 1660:1987 | Technical drawings - Dimensioning and tolerancing of profiles |
| ISO 2692-1988 | Technical drawings – Geometrical tolerancing – Maximum material principle |
| ISO 2692 Amd 1-1992 | Technical drawings - Geometrical tolerancing – Maximum material principle-  
Amendment 1: Least material requirement |
| ISO 5458:1998 | Geometrical Product Specifications (GPS) - Geometrical tolerancing - Positional tolerancing |
| ISO 5459-1981 | Technical drawings - Geometrical tolerancing – Datums and datum systems for geometrical tolerances  
Under revision |
| ISO/DIS 5459-1 | Geometrical product specification (GPS) - Datums for geometrical tolerancing -  
| ISO/DIS 5459-2 | Geometrical product specification (GPS) - Datums for geometrical tolerancing -  
<p>| ISO/8015-1985 | Technical drawings - Fundamental tolerancing principle |
| ISO 10578:1992 | Technical drawings - Tolerancing of orientation and location – Projected tolerance zone |
| ISO 10579:1993 | Technical drawings - Dimensioning and Tolerancing - Non-rigid parts |</p>
<table>
<thead>
<tr>
<th>ISO 14660-1</th>
<th>Geometrical product specification (GPS) - Geometric features - Part 1: General terms and definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO 14660-2</td>
<td>Geometrical product specification (GPS) - Geometric features - Part 2: Extracted median line of a cylinder and a cone; extracted median surface; local size of an extracted feature</td>
</tr>
<tr>
<td>ISO/TS 17450-1999</td>
<td>Geometrical product specification (GPS) - Model for geometric specification and verification.</td>
</tr>
</tbody>
</table>
Using this Guide

This guide is intended for the user who needs to become quickly familiar with the CATIA - Functional Tolerancing and Annotations Version 5 product. The user should be familiar with basic CATIA Version 5 concepts such as document windows, standard and view toolbars.

To get the most out of this guide, we suggest you start reading and performing the step-by-step tutorial "Getting Started".

The next sections deal with the more detailed capabilities of the product.
More Information

Prior to reading this book, we recommend that you read CATIA- Infrastructure User's Guide Version 5.

Getting Started

Before we discuss the detailed instructions for using the **Functional Tolerancing and Annotations** workbench, the following scenario aims at giving you a feel for what you can do. You just need to follow the instructions as you progress.

The Getting Started section is composed of the following tasks:

- Entering the Workbench
- Choosing a Standard
- Creating Textual Annotations
- Specifying a Single Datum
- Specifying Datum Targets
- Specifying a GD&T
- Hiding 3D Annotations
- Filtering
- Accessing the Set Properties

This scenario should take about 15 minutes to complete.

Eventually, the tolerated part will look like this:
Entering the Functional Tolerancing and Annotations Workbench

This task shows you how to enter the workbench and open the document you need for performing this tutorial.

1. Select the Start -> Mechanical Design -> Functional Tolerancing and Annotations command to launch the workbench.

   The Functional Tolerancing and Annotations workbench is opened. The commands are available in the toolbar to the right of the application window.

2. Open the Getting_Started.CATPart document.

   This is what you get:
Choosing a Standard

This task shows you how to set the standard you need for tolerancing your part.

1. Select the Tools -> Options command.
   The Options dialog box is displayed.

2. Click Mechanical Design then Part Design in the left-hand column.

3. Click the Tolerancing tab.

   The "Default standard at creation" option provides three conventional standards:
   - ANSI (American National Standards Institute)
   - ISO (International Organization for Standardization)
   - JIS (Japanese Industrial Standard)

4. If not already done, set ANSI as the standard to be used in the tutorial.

5. Click OK to validate and close the dialog box.

Note that this choice of standard must be expressed prior to specifying any
tolerance. After any creation in the workbench, the standard may be modified but
the corresponding syntax and semantic variation will not be taken into
consideration.
Creating Textual Annotations

This task shows you how to create two textual annotations related to the 3D geometry of the part.

1. Click the face as shown to define the surface and the location for the arrow head of the leader line.

2. Click the Text icon. 

   A message appears informing you that you cannot use the active view. Therefore, the application is going to display the annotation in an annotation plane (called "Front View Annotation Plane" too) normal to the selected face.

3. Click OK to close the message window.

   The Text Editor dialog box is now displayed:

4. Enter "Surface treatment" in the dialog box.

5. Click OK to end the text creation.

   The text is displayed in the 3D space in an annotation plane.
The textual annotation identified as Text.1 is added to the specification tree.

Note also that the application created three default front views, as shown in the tree:

Any front view created by default corresponds to an annotation plane (called "Front view annotation plane" too in the workbench). The three annotation planes defined by default correspond to the three planes of the coordinate system of the part under study.

6. To activate another annotation plane, double-click a new annotation plane. Use the plane as shown:
7. Select the inner cylindrical face:

8. Click the Text icon.

9. Enter "Surface 2" in the dialog box and click OK.
   You have created a second textual annotation:
For more about textual annotations, refer to *Specifying textual annotations*.
Specifying a Single Datum

This task shows you how to specify a single datum on a surface.

Datum elements are involved in geometric tolerancing specifications. For instance, when specifying an orientation or a position tolerance, you need to refer to datum elements for the specification.

1. Click the Datum Feature icon.

2. Select the attachment surface to be specified as datum.

The Datum Feature Modification dialog box that appears displays "A" as the default identifier.

3. Click OK to create the datum if the identifier corresponds to your choice.

The datum feature is created in a specific annotation plane. The "Datum" entity is added to the specification tree.

The datum is a 3D annotation without any semantic link to the geometrical tolerancing.
4. Select the datum and drag it. You can notice that it remains in the annotation plane.
Specifying Datum Targets

This task shows you how to specify three datum targets.

1. Click the Datum Target icon.

2. Select the face as shown:

3. In the dialog box that appears, click the diameter icon.

4. Enter 8 in the field opposite.

5. Enter "A1" in the field to the left.

6. Click OK to validate.

   You have created a datum target on datum plane A. The datum target corresponds to a 8mm-diameter surface. The name of the target is "A1".
7. Repeat the previous steps to specify two additional datum targets.

and obtain this result:
Specifying a GD&T

This task shows you how to specify a GD&T (Geometrical Dimension and Tolerance) directly on the 3D geometry. GD&Ts are specifications included in a tolerance frame.

1. Click the Geometrical Tolerance icon.

2. Select the front planar surface as shown:

A message window appears informing you that you cannot use the active view. Therefore, the application is going to display the annotation in an annotation plane normal to the selected face.

3. Click OK to close the message window.

The Geometric Tolerancing Parameters is displayed:
To create a GD&T you need to specify one geometric tolerancing symbol and fill in the tolerance value field.

When fulfilling the second line "Spec 2...", a second GD&T will be created. Both tolerancing specifications will be displayed as grouped.

4. Set the perpendicularity symbol to define Specification 1 (Spec 1).

5. The Tolerance Value frame includes an empty field in which you can enter the value of the tolerance. Enter 0.5.

6. To the right of this field, set the modifier to Maximum Material Condition.

7. Enter "A" as the datum element.

The dialog box now looks like this:
8. Click OK.

The geometrical tolerancing annotation is attached to the 3D part. The GD&T entity is added to the specification tree.

You have specified a perpendicularity of the front planar surface regarding to A datum surface. This tolerated surface shall be in 0.5-wide tolerance zone, on which an MMC (maximum material condition) is applied.
This task shows you how to hide the annotations you created.

1. Deselect the Hide/Show 3D Annotations icon. When entering the workbench, by default the option Show is on.

All annotations are hidden:

2. Click the icon again to restore the view.
Filtering Annotations

This task shows you how to filter the display of annotations. These filtering options let you focus on your area of investigation.

1. Click the Filter icon.

The Filter dialog box appears.

It provides the following information:
- number of tolerances specified in the document
- number of the tolerances selected according to the choice indicated in the two previous fields.

You can filter the display of annotations in the 3D viewer using the following criteria:
- by type: non semantic
- by sub-type: text, datums, datum targets, geometrical tolerances
- by feature or geometrical element
- by annotation plane
The default filter is ALL to display all the GD&T annotations.

The field entitled "Tolerances in the document" indicates the number of specified tolerances displayed attached to the 3D model.

However, when default tolerances are specified, the number of tolerances displayed attached to the model does not correspond to the number of tolerances effectively specified. The default tolerance annotation is displayed once and the default tolerance specification is applied to several entities. These several specific tolerated entities are considered in the count of the "Tolerances in the document" field.

2. Set the Filter choice field to "By sub-type".

3. Set the Datum sub-type and click Apply.

The Number of selected tolerances field displays "1".

4. Click OK to generate the chosen filter.

The only datum you created in this tutorial is consequently displayed attached to the geometry.
Accessing the Set Properties

This task shows you how to access the set properties and edit the set name.

1. Select "Tolerancing Set.1" in the specification tree.

2. Right-click and select the Properties contextual command.

The dialog box that appears displays information about the set, namely:
- the set name: as displayed in the specification tree
- the number of specifications: you have created seven specifications.
- the detail of these specifications: you have created two textual annotations, one datum, three datum targets and one GD&T.
3. Click the Feature Properties tab (if not available, click More) and enter a new name in the Set Name frame. For instance, enter "New Set".

4. Click OK to validate and close the dialog box.

The new name is displayed in the specification tree.
CATIA - Functional Tolerancing & Annotations allows you to perform the following basic tasks:

- Specifying Annotations
- Managing Annotations
- Managing Company Standards
**Specifying Annotations**

- **Create textual annotations**: click this icon, select a face and enter your text in the dialog box.

- **Specify datum elements**: click this icon, select the attachment surface and the anchor point of the datum feature, then enter the label in the dialog box.

- **Specify datum targets**: click this icon, select a face and enter your value and symbols in the dialog box.

- **Specify geometrical tolerance**: click this icon, select the element and define characteristics and values for Line 1 and/or Line2.
Creating a Textual Annotation

This task shows you how to create a text with a leader line. This text is assigned an unlimited width text frame. You can set graphic properties (anchor point, text size and justification) either before or after you create the free text.

Open the Getting_Started.CATPart document.

1. Click the Text icon.

2. Select a face or a set of faces to define a location for the arrow end of the leader.

If the active view is not valid, a message appears informing you that you cannot use the active view. Therefore, the application is going to display the annotation in an annotation plane normal to the selected face. For more information, see Defining Annotation Planes.

3. Click OK to close the message window.

The Text Editor dialog box is now displayed.
4. Enter your text, for example "Surface treatment" in the dialog box.

5. Click OK to end the text creation. You can click anywhere in the geometry area too.

The textual annotation appears in the geometry.

The textual annotation (identified as Text.xxx) is added to the specification tree.

The leader is associated with the element you selected. If you move either the text or the element, the leader stretches to maintain its association with the element.

Moreover, if you change the element associated with the leader, CATIA keeps the associativity between the element and the leader.

Note that using the Text Properties toolbar, you can define the anchor point, text size and justification.

You can move a text using either the drag capability. See Moving Annotations. Note also that you can resize the manipulators. For more information, refer to Customizing Functional Tolerancing and Annotations Workbench.
Specifying Datum Elements

This task shows you how to specify a datum element.

Before performing the task, here are a few principles you should be familiar with.

**Datum Elements and Datum Systems**

Datum elements and datum systems are only specified in case of geometrical tolerancing (not on dimensional tolerancing and except on form tolerancing). You can specify simple datum elements, common datum elements, datum targets or specified datum systems.

The tolerated feature is positioned relatively with the tolerance zone, and this set is positioned relatively with the datum or the datum system. These related positions will be specified using basic dimensions and they are displayed or not.

For more information about datum constitution and specification, see ISO 5459, ASME Y15.5M and ISO 1101.

**Datum System Composition**

When the identifiers are specified separately in each frame of the tolerance frame, the datum elements represent a datum system. A hierarchy is established between the datum elements. Reference A is the primary datum and reference B is the secondary datum. The datum system fitting would be performed first on datum A, then on datum B, with respect to A. By the way, a tertiary datum can also be specified.

**Notes**

- The datum elements have to be fitted successively (following their specification order) with respect to the hierarchy for the measurement computations.

- When only one identifier is specified in the tolerance frame, the datum is a single datum.

When two identifiers separated by a dash are specified in the tolerance frame, the datum is a common datum. The two datum elements are to be considered simultaneously. The datum system fitting would be performed in the meantime on datum A and on datum B (both datum elements have to be fitted simultaneously for measurement computations).

These symbols represent two specifications in the meantime: A | B and B | A.

When the identifiers are specified separately in the same frame of the tolerance frame, no hierarchy is established between the datum elements.

**Notes**

- This notation only exists in ISO. However, the ISO recommends not using this specification any longer.

- Two measurement computations have to be performed: the datum elements have to be fitted successively following their specification order and following the opposite specification order.

**Datum writing rules**
A capital letter is used to identify the datum element in the tolerance frame. The datum triangle may be filled or non-filled.

When the datum triangle is placed on the outline of the element or on its extension line, the datum element represents the surface itself or the 2D representation of the surface, which is a line.

When the datum triangle is placed in the alignment of the dimension line, the datum element represents the median element (usually an axis or a median plane).

When the datum triangle points directly on a median element, the datum element represents either the median element itself (usually an axis or a median plane) or the resulting median element of the collection of the considered elements.

The tolerance frame may also be related to the datum element using a leader line.

When the tolerance frame is related to one datum element through a leader line, the datum identifier may be omitted in the tolerance frame.

To perform this task, open the Getting Started.CATPart document.

1. Click the Datum Feature icon.

2. Select the attachment surface of the datum feature.

The Datum Feature dialog box displays with a default identifier.

3. Click OK to create the datum if the identifier corresponds to your choice.

The datum feature is created in a specific annotation plane. The "Datum" entity (identified as Datum..xxx) is added to the specification tree.

The datum is only a 3D annotation without any semantic link to the geometrical tolerancing.
4. Select the datum and drag it anywhere. You can notice that it remains in the annotation plane.

To edit a datum, double-click the datum, enter the new label in the Datum Feature Modification dialog box that is displayed, and click OK. The modification is simultaneously taken into account.

Two datum elements must not have the same label. A datum label must be unique to ensure that tolerance specifications are consistent.
Specifying Datum Targets

This task shows you how to specify datum targets on datum elements.

Before performing the task, here are a few principles you should be familiar with.

When defining a datum on planar or cylindrical surfaces the use of datum targets is optional.

A target element can be a point, line, circular or rectangular surface lying on the datum element:

- When the datum target is a point, then the circular frame is linked to a cross-placed on the surface. Framed dimensions shall define the location of the point.
- When the datum target is a line, then the circular frame is linked to a line placed on the surface. Framed dimensions shall define the length and the location of the line.
- When the datum target area is square or circular, the area dimensions are indicated in the upper compartment of the circular frame, or placed outside and connected to the appropriate compartment by a leader line (when there is no sufficient space within the compartment).

The minimum number of targets is defined by the datum depending on whether it is used as primary, secondary or tertiary datum in a reference frame.

For instance, if the datum feature is a cylinder, the targets may be two non-parallel lines, tangent to the cylinder and perpendicular to its centerline, in order to define “equalizing” datums (“V-type-equalizers”).

If the datum element is prismatic or complex, the use of datum targets is mandatory. In this case when selecting targets a message indicates the current step of the datum definition.

When the datum is established from datum targets, then the letter identifying the surface is repeated on the right side of the datum indicator followed by the list of numbers identifying the targets (separated by commas).

When there is no sufficient space within the compartment, the dimensions of the datum target area are placed outside the circular frame and connected to the appropriate compartment by a leader line terminated by a dot.

To perform this task, open the Getting_Started.CATPart document.
1. Click the Datum Target icon.

2. Select the face as shown:

3. In the dialog box that appears, click the diameter icon.

4. Enter 8 in the field opposite.

5. Enter A1 in the field to the left.

6. Click OK to validate.

You have created a datum target on datum plane A. The datum target corresponds to a 8mm-diameter surface. Its name is "A1" and it is identified as "Target..xxx" in the specification tree.
Creating Geometrical Tolerances (GD&Ts)

This task will show you how to create a geometrical tolerance annotation.

Before performing the task, here are a few principles you should be familiar with.

**Principles and Fundamental Rules for geometrical tolerancing**

All the dimension, form, orientation and position specifications (either on a geometric feature or on a geometric feature group of a part) are independent (see ISO 8015).

The dimensions of the features and their geometry are independent, regarding the form, the orientation and the position (see ISO 8015).

Each dimension shall have a tolerance, except for the dimensions specially identified as reference, maximum, minimum, or stock (commercial stack size). The tolerance may be applied directly to the dimension (or indirectly in case of basic dimensions), indicated by a general note, or located in a supplementary block of the drawing format, see ANSI Y14.1, ASME Y14.5M-1994).

Dimensioning and tolerancing shall be complete so there is full understanding of the characteristics of each feature. Neither scaling (measuring the size of a feature directly from an engineering drawing) nor assumption of a distance or size is permitted, except as follows: non-dimensioned drawings, such as loft, printed wiring, templates, and master layouts prepared an stable material, are excluded provided the necessary control dimensions are specified, (ASME Y14.5M-1994).

**Geometric Tolerancing**

Geometric Tolerance is the general term applied to the category of tolerances used to control form, profile, orientation, location and runout, (ASME Y14.5M-1994).

True Geometric Counterpart represents the theoretically perfect boundary (virtual condition or actual mating envelope) or best-fit (tangent) plane of a specified datum feature, (ASME Y14.5M-1994).

The geometrical tolerancing is divided into four types (by both ISO and ASME/ANSI):
- form tolerances,
- orientation tolerances,
- location or position tolerances,
- runout tolerances.

Geometrical tolerance objective is the boundary of spaces in which the tolerated feature has to be located with regards to the specified datums or datum system, to meet the tolerance specification. These particular tolerances allow to limit either actual feature defects or fitted features, with respect to nominal characteristics, and without considering the features’ dimensions.

Geometrical tolerancing is based on three feature types:
- tolerance features: a tolerated feature is an actual feature (point, line, surface, except for projected tolerance), or a fitted or a constructed feature. If the tolerated feature corresponds to a group, then each component of the group has the same nature, and the tolerated feature is a tolerated feature group.
- tolerance zone: a tolerance zone is a space (either surface or volume), bounded by one or several nominal features. That space defines the tolerated feature location in order to satisfy the tolerance specification, (see ISO 1101). When the geometrical tolerance applies on a feature group, then one tolerance zone is linked to one feature.
- datum elements or datum systems

Even if the GD&T creation is accomplished without any semantic links, we recommend you to specify datum elements and then declare your geometrical tolerancing with references.

To perform this task, open the [Associativity.CATPart](#) document.

1. Select the face as shown.

   Selecting an element or a point in free space defines a position for the end of a leader.
2. Click the Geometrical Tolerance icon.
   The Geometric Dimensioning and Tolerancing Parameters dialog box is displayed:

   ![Geometric Tolerancing Parameters dialog box]

3. Set the parallelism symbol to define Specification 1 (Spec 1).
   Here is the list of the symbols available:
4. The Tolerance Value frame includes the optional diameter zone symbol and an empty entry field in which you can enter the value of the tolerance. Enter 0.5.

5. It also includes tolerance feature modifiers. Set the Least Material Condition symbol.

   Here is the list of the symbols available:

<table>
<thead>
<tr>
<th>Tolerances</th>
<th>Characteristics</th>
<th>Symbol</th>
<th>Datum needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form</td>
<td>Straightness</td>
<td>-</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Flatness</td>
<td>□</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Roundness</td>
<td>○</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Cylindricity</td>
<td>ø</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Profile any line</td>
<td>≅</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Profile any surface</td>
<td>⊙</td>
<td>no</td>
</tr>
<tr>
<td>Orientation</td>
<td>Parallelism</td>
<td>//</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Perpendicularity</td>
<td>⊥</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Angularity</td>
<td>≢</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Profile any line</td>
<td>≅</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Profile any surface</td>
<td>⊙</td>
<td>yes</td>
</tr>
<tr>
<td>Location</td>
<td>Position</td>
<td>φ</td>
<td>yes or no</td>
</tr>
<tr>
<td></td>
<td>Concentricity (for centre points)</td>
<td>⊙</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Coaxiality (for axes)</td>
<td>⊙</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Symmetry</td>
<td>⊥</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Profile any line</td>
<td>≅</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Profile any surface</td>
<td>⊙</td>
<td>yes</td>
</tr>
<tr>
<td>Run-out</td>
<td>Circular run-out</td>
<td>↱</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>Total run-out</td>
<td>❈</td>
<td>yes</td>
</tr>
</tbody>
</table>
Maximum Material Condition (MMC)

Least Material Condition (LMC)

Envelope condition

Regardless of Feature of Size (RFS)

Free State

Projected Tolerance zone

Pressing Enter or Tab moves to the next field. The feature control frame is updated as you define values for each field.

The other fields are:
- primary datum feature modifier
- secondary datum feature modifier
- tertiary datum feature modifier

6. Click OK to confirm the operation and close the dialog box.

The geometrical tolerancing annotation is attached to the part. The GD&T entity (identified as GDT..xxx) is added to the specification tree.
Moving Annotations

This task shows you two ways of moving a textual annotation: by drag and drop, then by using coordinates. The operating mode described here applies to datum elements, datum targets and geometrical tolerances.

Open the Getting_Started.CATPart document and create a textual annotation.

1. Select the text (or its leader line).

2. Drag it to the desired location. Note that you can stretch or reduce the frame too.
3. Now, move it using coordinates: enter the value of your choice in the x field from the Orientation and Position toolbar, then enter another value to define the rotation A field. You can set the increment of your choice to define the rotation angle. For more information, see Customizing Functional Tolerancing and Annotations Workbench.

This is what you can obtain:
Managing Annotations

**Move annotations**: select the annotation and drag it to the desired location, or edit the entry fields from the Orientation and Position toolbar.

**Transfer annotations**: select the annotation, right-click to select the Transfer to View/Annotation Plane contextual command and select a new annotation plane.

**Edit annotation leader lines**: right-click the annotation and select the appropriate contextual command (Add Leader, Add a breakpoint, Move a leader, or Symbol shape).

**Make the position of a text associative**: multi-select the texts, make sure the textual annotations share the same z coordinate, right-click and select the Positional Link->Create contextual command and move the second textual annotation.
Transferring Annotations

This task shows you how to transfer a textual annotation from one view to another. The operating mode described here applies to datum elements, datum targets and geometrical tolerances too.

Open the Getting Started.CATPart document and create a textual annotation.

1. Select the textual annotation (or its leader).

2. Right-click to select the Transfer to View/Annotation Plane contextual command.

3. Select a new view in the tree or in the geometry. You can perform the operation on non-active views. The textual annotation is transferred to the new view.
Editing Annotation Leaders

This task shows you how to:

- add a leader
- add a breakpoint
- move a leader
- edit the shape of the arrow end

Open the *Getting_Started.CATPart* document and create a textual annotation.

1. Right click the textual annotation to which you want to add a leader.

2. Select the Add Leader contextual command.

3. Click where you want to begin the leader (arrow end).

   The leader appears.
4. If needed, position the leader at the desired location by dragging it.

5. To add a breakpoint, select the manipulator at the extremity of the arrow end and select the Add a Breakpoint contextual command.

The breakpoint appears in yellow. You can select it and drag the leader.
6. To edit the shape of the manipulator pointed at by the arrow, select the manipulator and the Symbol Shape contextual command.

This is the exhaustive list of the shapes available:

```
No Symbol
✓ Open Arrow
✗ Transparent Arrow
✓ Opaque Arrow
✓ Filled Arrow
✓ Transparent Circle
✓ Opaque Circle
✓ Filled Circle
✗ Crossed Circle
✓ Opaque Square
✓ Filled Square
✓ Opaque Triangle
✓ Filled Triangle
```

7. For instance, select the Crossed Circle shape. You obtain this result:
Making the Position of a Text Associative

This task shows you how to set a positional link between a text and another element. This allows you to move several annotations in only one interaction.

Open the Getting Started.CATPart document.

1. Multi-select the texts (text itself, frame or leader). These texts must belong to the same active view.

2. Make sure the textual annotations share the same z coordinate: enter any value in the z coordinate field from the Position and Orientation toolbar. The textual annotations are then moved accordingly.

3. Right click and select the Positional Link->Create contextual command.

4. Move the second textual annotation: both texts are moving and their distance remains the same.
5. Now, if you move the first annotation you selected, only this annotation is moved.

6. To delete the associativity, just use the Positional Link->Delete contextual command.
Managing Company Standards

**Set graphic properties:** select the annotation then the desired options from the Text Properties toolbar.

**Define default properties:** select the annotation and right-click to select the Set as Default contextual command.

**Edit graphic properties:** select the annotation, the Edit-> Properties command and enter the parameters of your choice to edit the font and the text.

**Copy graphic properties:** multi-select the textual annotations which graphic properties are to be modified, click this icon, and select the text to be used as the graphic reference.

**Manage company standards:** choose the file you need among the three ASCII files available and optionally add comments.
Setting Graphic Properties

This task shows you how to set font, size, justification, and other display properties for a textual annotation. You will learn how to set the properties of your choice, then apply default properties.

Note that the operating mode described here is valid for datum elements, datum targets and geometrical tolerances too.

Open the Getting_STARTED.CATPart document, deactivate the Use Default icon from the Style toolbar and create a textual annotation.

1. Select the textual annotation of interest.

2. As the Use Default icon is deactivated, you can access the desired options from the Text Properties toolbar. For instance, click the Bold and Underline options. These properties will be applied to any new textual annotation you will create from now on provided the Use Default icon remains deactivated.

The textual annotation is edited accordingly.
3. Create another textual annotation. Its graphic properties are the same as the ones previously defined. Note that you can edit but also copy and paste graphic properties.

4. Click the Use Default icon.

5. Specify another textual annotation.

It inherits the graphic properties defined as default properties. This explains why the font color is green:

The following table describes the options available from the Text Properties toolbar:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon](Monospac821 BT)</td>
<td>Font Name</td>
<td>Changes the style of text.</td>
</tr>
<tr>
<td>Icon</td>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Font Size" /></td>
<td>Font Size</td>
<td>Changes the size of text.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Bold</td>
<td>Changes the weight of text. Toggles between normal and heavy (bold).</td>
</tr>
<tr>
<td><img src="image" alt="Italic" /></td>
<td>Italic</td>
<td>Changes the angle of text. Toggles between normal and slanted (italic).</td>
</tr>
<tr>
<td><img src="image" alt="Underline" /></td>
<td>Underline</td>
<td>Adds a line under the text.</td>
</tr>
<tr>
<td><img src="image" alt="Strikethru" /></td>
<td>Strikethru</td>
<td>Adds a line through the center of the text.</td>
</tr>
<tr>
<td><img src="image" alt="Overline" /></td>
<td>Overline</td>
<td>Adds a line above the text.</td>
</tr>
<tr>
<td><img src="image" alt="Superscript" /></td>
<td>Superscript</td>
<td>Raises the text above the normal text line.</td>
</tr>
<tr>
<td><img src="image" alt="Subscript" /></td>
<td>Subscript</td>
<td>Lowers the text below the normal text line.</td>
</tr>
<tr>
<td><img src="image" alt="Left Justify" /></td>
<td>Left Justify</td>
<td>Aligns multiple lines of text in the center of the text frame.</td>
</tr>
<tr>
<td><img src="image" alt="Center Justify" /></td>
<td>Center Justify</td>
<td>Aligns multiple lines of text along the left edge of the text frame.</td>
</tr>
<tr>
<td><img src="image" alt="Right Justify" /></td>
<td>Right Justify</td>
<td>Aligns multiple lines of text along the right edge of the text frame.</td>
</tr>
</tbody>
</table>
| ![Anchor point](image) | Anchor point   | Changes the position of the point that connects the text to the drawing or to an element. There are nine choices:  
  - Along the top of the text: left, center, or right  
  - Along the vertical center of text: left, center or right  
  - Along the bottom of the text: left, center, or right |
<table>
<thead>
<tr>
<th>Frame</th>
<th>Draws a single-line frame around the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Symbol</td>
<td>Inserts several symbol types including geometrical tolerancing ones especially in the text editor.</td>
</tr>
</tbody>
</table>
Defining Default Properties

This task shows you how to set graphic properties as default properties. Later on, each time you will specify annotations, your annotations will then inherit these properties if you are using the Use Default mode.

Open the Getting_Started.CATPart document, deactivate the Use Default icon and create a textual annotation using the bold graphic option.

1. Create a second textual annotation. As the Use Default icon is deactivated, this textual annotation inherits the graphic properties of the textual annotation you created before.

2. Edit the properties of this new annotation. For more information, refer to Editing Graphic Properties. For instance, change the font color to green.
3. Select the annotation and right-click to select the Set as Default contextual command. From now on, the annotations you will specify while having the Use Default icon activated, will be green.

4. Activate the Use Default icon and create a third textual annotation. This annotation now inherits the graphic properties of the previous annotation.
Editing Graphic Properties

This task shows you how to edit the graphic properties of a textual annotation. The operating mode described here is valid for any annotation, but note that the options you access depend on the type of annotation you select.

Open the Getting_Started.CATPart document and create an annotation.

1. Select the annotation.

2. Select the Edit-> Properties command.

   You can also right click and select the Properties contextual command. The Properties dialog box that appears displays two tabs.
The Font tab is dedicated to several options defining the font. These options are the same as the ones available from the Text Properties toolbar, except for the color you can assign.

3. For example, set the blue color to your text.

4. Click the Text tab.

The options available let you edit the position of your text as well as the leader properties (not the arrows, for more information, see Editing Annotation Leaders).
5. Set the Thickness option to 2.00 mms to make the leader more visible.

6. Click the More... button.
   This displays the Feature Properties tab that lets you edit the name of your text.
7. Enter "First Text" in the field.

8. Click OK to confirm and close the dialog box.

You obtain this:
This task shows you how to copy the graphic properties of a textual annotation to other existing texts. Note that the operating mode described here applies to datum elements, datum targets and geometrical tolerances too.

Open the Getting_Started.CATPart document and create three textual annotations as shown in the picture below.

1. Multi-select the textual annotations which graphic properties are to be modified.

2. Click the Copy Object Format icon.

3. Select the text to be used as the graphic reference for the texts you selected. In our example, select "Surface treatment".

The graphic properties assigned to the text used as the reference are now copied onto the multi-selected free texts to be modified.
Managing Standards

This section lists and explains the parameters contained in the standard ASCII file which enables the customization of annotation elements. Please note that this file contains a large number of parameters. The parameters not documented here only apply to Drafting applications.

The values of the parameters in the file are taken into account when the first FD&T view is created, based on the current standard. Once the first view has been created, modifying the standard file will not affect this CATPart document.

There are 3 standard ASCII files, one for each international standard available. They are located in install_root/reffiles/Drafting

- ISO.CATDrwStandard
- ANSI.CATDrwStandard
- JIS.CATDrwStandard

For more information, see Choosing a Standard.

### Standards

#### General Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Parameter Names</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>International standard</td>
<td>ParentStandard</td>
<td>[ISO/ANSI/JIS]</td>
<td>Each used-defined standard is based on one of 3 international standards. This sets some basic parameters. This keyword should always be the first in the standard file</td>
</tr>
</tbody>
</table>

#### Leader End Symbols

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Parameter Names</th>
<th>Values</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow size and angle</td>
<td>SYMBArrowSide</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Variable</td>
<td>Unit</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>Closed arrow size and angle</td>
<td>SYMBClosedArrowSide</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SYMBClosedArrowAngle</td>
<td>(degrees)</td>
<td></td>
</tr>
<tr>
<td>Filled arrow size and angle</td>
<td>SYMBFilledArrowSide</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SYMBFilledArrowAngle</td>
<td>(degrees)</td>
<td></td>
</tr>
<tr>
<td>Symmetric arrow size and angle</td>
<td>SYMSymetricArrowSide</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SYMSymetricArrowAngle</td>
<td>(degrees)</td>
<td></td>
</tr>
<tr>
<td>Slash size</td>
<td>SYMBSlashLength</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Unit</td>
<td>Diagram</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>Circle size</td>
<td>SYMBCircleDiameter</td>
<td>(mm)</td>
<td><img src="link" alt="Circle" /></td>
</tr>
<tr>
<td>Filled circle size</td>
<td>SYMBFilledCircleDiameter</td>
<td>(mm)</td>
<td><img src="link" alt="Filled Circle" /></td>
</tr>
<tr>
<td>Scored circle size</td>
<td>SYMBSymmetricCircleDiameter</td>
<td>(mm)</td>
<td><img src="link" alt="Scored Circle" /></td>
</tr>
<tr>
<td>Crossed circle size</td>
<td>SYMBCrossCircleDiameter</td>
<td>(mm)</td>
<td><img src="link" alt="Crossed Circle" /></td>
</tr>
<tr>
<td>Triangle size</td>
<td>SYMBTriangleSide</td>
<td>(mm)</td>
<td><img src="link" alt="Triangle" /></td>
</tr>
<tr>
<td>Parameters</td>
<td>Parameter Names</td>
<td>Values</td>
<td>Descriptions</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>-------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Filled triangle size</td>
<td>SYMBFilledTriangleSide</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td>Plus size</td>
<td>SYMBPlusHeight</td>
<td>(mm)</td>
<td></td>
</tr>
<tr>
<td>Cross size</td>
<td>SYMBCrossSide</td>
<td>(mm)</td>
<td></td>
</tr>
</tbody>
</table>

**Annotations**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Parameter Names</th>
<th>Values</th>
<th>Descriptions</th>
</tr>
</thead>
</table>
| Text angle       | TXTAngleAllowed      | [ 1 / 2 ]
1 = 0 to 360 degrees
2 = -90 to 90 degrees |              |
### Adding Comments Into Standard Files

You can add comment lines in the standard files. These comments will have no effect on the application behavior.

This is done on an individual line by starting the line with the `#` character, as in the following example:

```
# This is a comment line
```

This can also be done on several lines by putting `BEGIN_COMMENT_BLOCK` before the first line to comment, and `END_COMMENT_BLOCK` after the last line to comment.

```
BEGIN_COMMENT_BLOCK
this paragraph is all commented and
will not be taken into account
END_COMMENT_BLOCK
```
Upgrading Standard Files from Previous Releases

From one release to another the standard files may be enriched with additional parameters and keywords. All added or modified keywords will be mentioned by an appropriate comment line.

You should control the enhancements to the new standard files, in order to reflect the modifications to your customized files.
CATIA - Functional Tolerancing & Annotations allows you to perform the following advanced tasks:

- Defining Annotation Planes
- Reporting
- Customizing the Reporting
- Associativity
Defining Annotation Planes

As soon as you use any command of the Functional Tolerancing & Annotations workbench, the application creates three default annotation planes. These planes correspond to the three planes of the coordinate system.

To activate a plane, either you double-click it or use the Activate View contextual command. The active annotation plane is underlined in the tree and its geometric representation is red.

Other annotation planes can be specified around the geometry for automatically generating the corresponding views, sections and cuts of the 2D drawing. These particular annotation planes are:

- **Front View** (Annotation Plane)
  
  This specific annotation plane allows you to manage 3D annotations:
  - located in planes both parallel to this annotation plane and in the background and foreground spaces bounded by this annotation plane (or in any plane of the direction of planes defined by this annotation plane),
  - related to the geometry finding an intersection with this annotation plane, and
  - lying on/belonging to this annotation plane

  This option allows you to specify a particular annotation plane for generating embedded 2D front/projection views, in the Generative Drafting workbench, during the 2D extraction of the 3D part and of the 3D annotations.

- **Section View** (Annotation Plane)
  
  This specific annotation plane allows you to manage 3D annotations:
  - located in planes both parallel to this annotation plane and in the background space bounded by this annotation plane,
  - related to the geometry finding an intersection with this annotation plane, and
This option allows you to specify a particular annotation for generating embedded 2D section views, in the Generative Drafting workbench, during the 2D extraction of the 3D part and of the 3D annotations.

**Section Cut** (Annotation Plane)

This specific annotation plane allows you to manage 3D annotations:
- only related to the geometry finding an intersection with this annotation plane
- only lying on/belonging to this annotation plane and

This option allows you to specify a particular annotation for generating embedded 2D section cuts, in the Generative Drafting workbench, during the 2D extraction of the 3D part and of the 3D annotations.

---

This task shows you how to create a section view. The steps described here also apply to Section Cut and Front View commands.

Open the Getting Started.CATPart document.

1. Click the Section View icon.

2. Select a planar element. For instance, select the face as shown:
The section view is created. Its axis is green.

It is identified as "SectionView" in the specification tree, and it is underlined as it becomes the active annotation plane.

This particular annotation plane can be translated along the z axis of its local coordinate system. Only negative z values can be used to define the translation, since the section view annotation plane will be used for the extraction of section views in the Generative Drafting workbench.

To translate a section view annotation plane, just select the section view annotation plane and enter the desired value in the z field from the Position and Orientation toolbar.
Section cuts are represented by a yellow axis and are identified as "SectionCut" in the specification tree.

This particular annotation plane cannot be translated along the z axis of its local coordinate system, since the section cut annotation plane will be used for the extraction of section cuts in the Generative Drafting workbench.

Front views are represented by a blue axis and are identified as "FrontView" in the specification tree.

This particular annotation plane can be translated along the z axis of its local coordinate system. Negative and positive z values can be used to define the translation, since the front view annotation plane will be used for the extraction of front views in the Generative Drafting workbench.

To translate a front view annotation plane, just select the annotation plane and enter the desired value in the z field from the Position and Orientation toolbar.
Generating a Check Report

This task shows you how to generate a report checking whether tolerancing rules are respected or not. These rules depend on the standard you are using.

Open the Report.CATPart document.

1. Make sure the options "HTML" and "Both" are activated in the Tolerancing Rule Settings dialog box. For more information, refer to Customizing the Report.

2. Click the Report icon.

The application generates the report in the browser you usually use and displays it onscreen using the options as specified in the Custom Report command. This is an example of what we can get in a .htm file:

<table>
<thead>
<tr>
<th>Current Document Name:</th>
<th>E:\users\cbr\Report.CATPart</th>
<th>09/21/00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists Of Check:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Validity</td>
<td>RuleSet</td>
<td>Rule Name</td>
</tr>
<tr>
<td>✔️</td>
<td>sequential datum target numbers</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>datum target label referencing to an existing datum label</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>datum target label ended by a positive number</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>datum label length</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>identical datum label letter</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>authorized datum label letter</td>
<td>100%</td>
</tr>
<tr>
<td>✔️</td>
<td>datum label</td>
<td>100%</td>
</tr>
</tbody>
</table>
The file provides you with the path of the CATPart document you are using and the date of generation. In our example, all the rules are respected as mentioned by the green symbols and the 100% success message.

3. Click any rule name to obtain detailed information.

For example, you can obtain this

4. Edit Datum Target 3 by entering CC3 in the dialog box.

5. Generate the report again.

The report now indicates that the rule "The numbers identifying datum targets shall be sequential and begin with 1" is not respected because no datum CC3 can be found.
### Lists Of Check:

<table>
<thead>
<tr>
<th>Validity</th>
<th>RuleSet</th>
<th>Rule Name</th>
<th>Percent of Success</th>
<th>Help</th>
<th>Correct Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌</td>
<td>sequential</td>
<td>datum target numbers</td>
<td>66%</td>
<td>The numbers identifying datum targets shall be sequential and begin with 1</td>
<td>Edit the datum target label</td>
</tr>
<tr>
<td>❌</td>
<td>datum label</td>
<td>referencing to an existing datum label</td>
<td>66%</td>
<td>A datum target label shall reference to an existing datum label</td>
<td>Edit the datum target label</td>
</tr>
<tr>
<td>✔️</td>
<td>datum label</td>
<td>ended by a positive number</td>
<td>100%</td>
<td>A datum target label shall be ended by a positive number</td>
<td>Edit the datum target label</td>
</tr>
<tr>
<td>✔️</td>
<td>datum label</td>
<td></td>
<td>100%</td>
<td>A datum label shall not be composed with more</td>
<td>Edit the</td>
</tr>
</tbody>
</table>

6. To generate the other type of report, use the [Customize Report](#) command to set the options "File" and "Both"

7. Click the Report icon.

The application generates the report which indicates too that Datum Target 3 is to be edited.
Note that you cannot edit tolerancing rules.
Customizing Your Check Report

The data logged in the generated report as well as the report format depend on the rule base settings. This task explains how to specify these settings.

Open any document or the Report.CATPart document if you wish to generate the report after performing this task.

1. Click the Customize Report icon.
   The Tolerancing Rule Settings dialog box is displayed:

   ![Tolerancing Rule Settings dialog box]
   
   - **Output Format**
     - Html
     - File
   - **Output Directory**
     - C:\WINNT\Profiles\cel\Local Setting
   - **Description Length**
     - Long
     - Short
   - **Visualization type**
     - Passed
     - False
     - Both
   - **Show Results**
     - By Rule
     - By Object
     - By Rule State
   - **Others**
     - Traces
     - Force Solve
2. Two output formats are available:
   - Html
   - File

   If you check the Html format, you then can choose between the following options:

   - **Passed**: to include only information about the features for which the checks are valid
   - **False**: to include only information about the features for which the checks are invalid.
   - **Both**: to include all information about all the features on which a check has been applied.

   You also need to check

   - **Automatic Correct**: to start the user function specified at the check creation (Correction Tab)

   If you check the File format (a non-editable format), check:

   - **Long**: to include the Help message specified at the check creation
   - one of the options proposed below Show Results to organize your report data into categories.

3. Click OK to apply the settings to the rule base.

   Unless you want to modify the check report characteristics, you don't have to re-specify the settings each time you generate a report.
Managing Associativity Between Elements

Different types of associativity characterize this workbench. Associativity between the 3D part and the navigation tree. Actually, when launching CATIA - Functional Tolerancing and Annotations, the option is activated by default. This option is automatically deactivated, when quitting the workbench. This option can be integrated in any other workbench.

This associativity is an incomplete semantic associativity. This option allows queries on text, datum, datum target and GD&Ts. For a given annotation, only the related (toleranced) elements is highlighted, and vice-versa.

This task shows you the existing associativity between a leader and the location specification.

Open the **Associativity.CATPart** document.

1. Select the leader line as shown:

   ![Leader line selection](image)

   This location specification is defined on a pattern of holes. Any toleranced hole of the pattern is then highlighted.
2. Select the yellow manipulator and start dragging the arrow head.

A yellow temporary trace is displayed. It corresponds to the intersection between the annotation plane and the corresponding toleranced elements. This trace defines all the possible positions for the arrow head semantically correct for the selected tolerancing annotation.

In our example, the toleranced elements are a group of five holes, this is why we obtain five yellow traces:
3. For example, drag and drop the arrow head on the trace to the right. You can obtain this:
Workbench Description

The CATIA - Functional Tolerancing and Annotations Version 5 application window looks like this:
This section presents the main menu bar available when you run the application and before creating or opening a document:

```
Start   File   Edit   View   Insert   Tools   Windows   Help
```

**Insert**

**For...**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with Leader</td>
<td>Creating a Textual Annotation</td>
</tr>
<tr>
<td>Datum Feature</td>
<td>Specifying Datum Elements</td>
</tr>
<tr>
<td>Geometrical Tolerance</td>
<td>Specifying Geometrical Tolerances</td>
</tr>
<tr>
<td>Add Leader</td>
<td>Editing Annotation Leaders</td>
</tr>
<tr>
<td>Front View</td>
<td>Defining Particular Annotation Plan(s)</td>
</tr>
<tr>
<td>Section View</td>
<td>Defining Particular Annotation Plan(s)</td>
</tr>
<tr>
<td>Section View (Annotation Plane)</td>
<td></td>
</tr>
</tbody>
</table>

**For...**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section Cut (Annotation Plane)</td>
<td></td>
</tr>
</tbody>
</table>
Annotations Toolbar

See [Creating a Textual Annotation](#)

See [Specifying Datum Elements](#)

See [Specifying Datum Targets](#)

See [Specifying Geometrical Tolerances (GD&Ts)](#)
See Setting Graphic Properties
Views Toolbar

See Defining Particular Annotation Planes

See Defining Particular Annotation Planes

See Defining Particular Annotation Planes
Visualization Toolbar

See Hiding 3D Annotations

See Managing Associativity Between Elements

See Filtering Annotations
Position and Orientation Toolbar

See Moving Annotations
Reporting Toolbar

See Generating a Check Report

See Customizing your Check Report
Style Toolbar

See Defining Default Properties
See Copying Graphic Properties
This task will show you how to customize the rotation of the elements and the display of the manipulators.

1. Select the Tools -> Options... command.
   
   The Options dialog box is displayed.

2. Click Mechanical Design then Part Design in the left-hand column.

3. Click the Tolerancing tab.
   
   Different options are available. For information about standards, see Choosing a Standard.

4. Check the Rotation Snap Angle to define an angle for rotating elements. This option is used to rotate text elements (text, frame, or leader). For more information, see Moving Annotations.

5. Enter the desired angle value. The rotation will be snapped to the increment you enter.

6. The Manipulators frame is reserved for defining whether manipulators can be zoomed in or not. You can also assign a size to the manipulators.
7. Uncheck the Zoomable option if you do not wish to make the manipulators zoomable.

8. Click Ok to confirm and close the dialog box.
**Glossary**

### A

**Associated Derived Feature**
Center point, axis or median plane derived from one or more associated integral features (ISO 14660)

**Associated Integral Feature**
Feature of perfect form associated to the extracted integral feature in accordance with specified conventions (ISO 14660)

### C

**Common Datum**
Datum based on two or more surfaces considered simultaneously— (ISO/CD 5459-1:1998)

### D

**Datum**
A theoretically exact point, axis, or plane derived from the true geometric counterpart of a specified datum feature. A datum is the origin from which the location or geometric characteristics of features of a part are established, (ASME Y14.5M-1994).

Situation feature used to define the position and/or orientation of a tolerance zone or to define the position and/or the orientation of the virtual conditions (in the case of the complementary requirements, e.g maximum material requirement), (ISO/CD 5459-1:1998(E)).

**Datum System**
Ordered list of at least two datums and at most three datums, which may be single or common datums, (ISO/CD 5459-1:1998(E)).

Note: A datum-system is used to define the position and/or orientation of a tolerance zone or to define the position and/or the orientation of the virtual condition (in the case of complementary requirements, e.g maximum material requirement).

**Datum Target**
A specified point, line, or area on a part used to establish a datum, (ASME Y14.5M-1994).

Portion of an integral feature (surface) which can be a point, a line or an area and which is used for establishing a datum, (ISO/CD 5459-1:1998(E)).

**Datum Feature**
An actual feature of a part that is used to establish a datum, (ASME Y14.5M-1994).

**Derived Feature**
Center point, median line or median surface from one or more integral features (ISO 14660)

Examples:
1- The center of a sphere is derived feature obtained from the sphere, which is an integral feature.
2. The median line of a cylinder is a derived feature obtained from the cylindrical surface, which is an integral feature.
Extracted Derived Feature

Center point, median line or median surface derived from one or more extracted integral features (ISO 14660).

Note: For convenience:

- the derived median line of an extracted cylindrical surface is called an extracted median line (see ISO 14660-2).
- the derived median surface of 2 opposite extracted planar surfaces is called an extracted median surface (see ISO 14660-2).

Extracted Integral Feature

Approximated representation of the real (integral) feature, obtained by extracting a finite number of points from the real (integral) feature performed in accordance with specified conventions. (ISO 14660)

Note: This representation is defined according to the required function of the feature. Several such representations may exist for each real (integral) feature.

Feature

The general term applied to a physical portion of a part, such as a surface, pin, tab, hole or slot, (ASME Y14.5M-1994).

(geometric feature), point, line or surface, (ISO 14660-1).

Feature of Size

Geometric shape defined by a linear or angular dimension which is a size(ISO 14660)

Notes

1- The features of size can be a cylinder, a sphere, two parallel opposite surfaces, a cone or a wedge.

2- In standards such as ISO 286-1 and ISO/R 1938 the terms “plain workpiece” and “single features” are used with a meaning close to “feature size”.

Geometric Feature

Point, line or surface (ISO 14660)

Integral Feature

Surface or line on a surface (ISO 14660)

Note: An integral feature is intrinsically defined.

Nominal integral feature

Theoretically exact integral feature as defined by a technical drawing or by other means (ISO 14660)

Nominal Derived Feature

Center point, axis or median plane derived from one or more nominal integral features (ISO 14660)

Note: On the technical drawing nominal derived features are mostly represented by chain lines (dash-dotted lines).
<table>
<thead>
<tr>
<th>R</th>
<th>Real (integral) Feature</th>
<th>Integral feature part of a real surface of a workpiece limited by the adjacent real (integral) features (ISO 14660). Note: No real derived feature exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Real Surface of a Workpiece</td>
<td>Set of features which physically exist and separate the entire workpiece from the surrounding medium (ISO 14660).</td>
</tr>
<tr>
<td></td>
<td>Restricted Surface</td>
<td>Portion of an integral feature (surface) which is an area and which is used for establishing a datum – (ISO/CD 5459-1:1998) Note: the area of a restricted surface is relatively large compared with the complete surface.</td>
</tr>
<tr>
<td>S</td>
<td>Single Datum</td>
<td>Datum based on one surface considered alone – (ISO/CD 5459-1:1998)</td>
</tr>
<tr>
<td></td>
<td>Situation Feature</td>
<td>Ideal feature which is a point, a straight line, a plane or a helix, from which the position and/or the orientation of a feature can be defined – (ISO/CD 5459-1:1998) Note: Situation features are defined by and are characteristics of the class of surface involved.</td>
</tr>
<tr>
<td></td>
<td>Surface class</td>
<td>Group of surfaces having the same degree of freedom for which the surfaces are unvarying, (ISO/CDIS 5459-1:1998(E)).</td>
</tr>
<tr>
<td>T</td>
<td>Tolerance zone</td>
<td>Space limited by one or several geometrically perfect lines or surfaces, and characterized by a linear dimension, called a tolerance (ISO/FDIS 1101:2000(E))</td>
</tr>
</tbody>
</table>
Index

A

ANSI ➤
active annotation plane ➤
Add a Breakpoint command ➤
angle ➤
annotation ➤, ➤
annotation plane ➤
arow ➤
associativity ➤

B

blue ➤

C

circle ➤
contextual commands
    Add a Breakpoint ➤
    Add Leader ➤
    Activate View ➤
    Positional Link ➤, ➤
    Properties ➤
    Set as Default ➤
    Symbol Shape ➤
    Transfer to View/Annotation Plane ➤
commands
    Copy Object Format ➤
    Customize Report ➤
    Datum Element ➤
    Datum Target ➤
    Filter ➤
Geometrical Tolerance
Hide/Show
Report
Text
Use Default
Copy Object Format command
common datum
customizing

datum element
datum system
Datum Target command
dot

Filter command
front view

GD&T
Geometrical Tolerance command
green
Hide/Show command

ISO
identifier
italic

JIS

leader line
left justify

manipulator
modifiers

normative references
overline

parameters
Positional Link command
properties

red
Report command
right justify

section cut
section view
semantic link
set
Set as Default command
shape
single datum
standard

strikethru
subscript
superscript
symbols
Symbol Shape command
textual annotation
   creating ➤
   moving ➤
   properties ➤, ➤
   rotating ➤
tolerancing ➤,
Transfer to View/Annotation Plane command ➤
triangle ➤, ➤

underline ➤
Use Default command ➤, ➤
view
different types ➤
activating ➤
showing ➤
hiding ➤

yellow ➤